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Preparation of a 3D-model



In what format to work

Our service supports loading models in a variety of formats (glb, gltf, usdz, fbx, stl, obj, 3ds, 3dm, 3mf, dxf, iges, igs, step, stp, 
brep, ifc, dae, kmz), but for maximum realism, we recommend working with the GLB format (an optimized version of the GLTF
format). This format is specially designed for realistic demonstration of models in the Web space.

The most suitable program for working with this format is Blender. This is a modern, actively developing and free 3D-graphics 
editor. Only it allows you to properly prepare a model with textures.

In the future, we will mainly focus on this format of 3D-modeling.



Exporting a model to GLB from other formats

In the Blender editor, you can open many file formats and 
correctly export them to GLB via the File => Import menu. The 
most popular of them are: OBJ, STL, FBX.



Basic model settings

For the convenience of using the model in our service, we 
recommend performing the following simple actions:

• Remove all kinds of nodes, leaving only meshes

• Set the geometries of all meshes in their geometric centers 
(in Blender, select Set Origin => Origin to Geometry => Bound 
Center, in 3D max this is done using Pivot Point, and for 
automatic correction there is a setting inside the editing of 
the project inside the service (Scene parameters => Start view 
=> Fix the centers of the model parts), which may not work 
correctly for complex structured models)

• Bring the model to real dimensions in meters and reset all 
meshes to rotations and scale (in Blender, select meshes, 
Ctrl-A and select Rotation and Scale).

• Place the model in the center of all three coordinates

https://www.youtube.com/watch?v=p2-LOnjqh3Y


Centering the model

• If the model is in the form of a single mesh, then it is enough to set zero coordinates for it.

• Otherwise, you can select all the meshes, clone them, then combine them into one mesh, then set it at the center of the 
coordinates, after which, combine all the meshes with this mesh through binding to the vertices, and delete it.

• If there is no animation in the model, the service tries to center the model automatically through the setting Scene Parameters 
=> Start view => Place the model in the center.



Working with dimensions and details

For correct display in augmented reality, the model must have real 
dimensions in meters.

To smooth the model in Blender, select the Subdivision Surface
modifier and increase the Levels Viewport to the appropriate level.



Checking and correcting normals

When working with the model, check the state of the normals:

• Select the model and go to Overlays
• Select the Face Orientation checkmark

If the model is red, normals are turned out. To fix this, go into 
edit mode, select all or part of the model, press ALT + N and 
select Flip.

To prevent this problem from interfering with your work:

• Go to the Material Properties tab on the right
• Go to Settings and uncheck Backface Culling



The GLB format is demanding of materials, so special preparation is 
needed for it. It is important to familiarize yourself with the acceptable 
properties of the material for the GLB format.

The parts of the model (hereinafter meshes) that users can repaint 
(change color, texture) should have only one material.

We recommend working with materials in Blender, but keep in mind 
that only Image Texture, Normal Map and other maps can be used in 
Shader Editor.

If you work in 3D max and use V-RAY or CORONA materials, then to 
export to GLB format, you must first export the model to FBX, and 
then import it into Blender and export to GLB.

If you use CORONA or several V-RAY materials, you will additionally 
need to reconnect textures in Blender according to their names.

For more information about exporting from 3D max to GLB, see here.

Features of working with materials

https://docs.blender.org/manual/en/2.80/addons/io_scene_gltf2.html
https://docs.blender.org/manual/en/2.80/addons/io_scene_gltf2.html
https://www.youtube.com/watch?v=xEyGQrQw2QE


How to apply texture

To apply texture to a model in Blender:

• We select the model

• At the bottom, select the Shader Editor and transfer the desired 
texture there

• We connect the texture with our model via Color to Base Color

• If the texture does not lie flat, then go to the UV Editing panel. 
Two windows appear, in the right window we switch to Edit Mode
and select the model. The expanded model appears in the left 
window. Align the texture.



How to apply texture

To apply texture to a model in Blender:

• We select the model

• At the bottom, select the Shader Editor and transfer the desired 
texture there

• We connect the texture with our model via Color to Base Color

• If the texture does not lie flat, then go to the UV Editing panel. Two 
windows appear, in the right window we switch to Edit Mode and 
select the model. The expanded model appears in the left window. 
Align the texture.

• If the Mapping block is used to scale the texture and we want the 
user to be able to replace this texture with another one, then we 
need to delete this block and use only the method described above.



Making the material transparent

• We select the necessary material.

• Go to the Material Properties => Settings on the 
right, select Alpha Blend in the Blend Mode
section, and Alpha Hashed in the Shadow Mode
section.

• We head to the Shader Editor and set the 
corresponding value in Alpha (the lower the 
value, the more transparent the object will be).



Creating a glass material

• We select the mesh. Go to the Shader Editor. 
Creating a new material using the New button.

• We set Transmission to 1.0,
and Roughness to 0.0.

• Go to the Material Properties => Settings on the 
right and select Alpha Clip in the Blend Mode
section.

• We return to the Shader Editor and set the 
corresponding value in Alpha (the lower, the 
more transparent the object will be).



Packing textures

In order for the textures of your model to be displayed in the 
service, it is necessary that you attach them to your model file. 
Depending on the program you are working in, this can be done in 
different ways:

• In Blender, select File => External Data => Automatically Pack 
Resources from the menu

• In order to properly export materials from 3D max, it is important 
that they are all in the same folder (how to do this).

https://www.youtube.com/watch?v=sYd7xU_Lo_o


Creating an animation

• We select the mesh. Go to the Timeline bottom 
menu. Turning on the animation.

• On the right, go to Object Properties. We include 
coordinates and degrees. So we set the origin.

• Move the blue cursor to the required time interval.
At the same time, we move the mesh to the required 
place.

• Repeat these actions until the end of the animation. 
After the end, turn off the animation and click on 
start to view what happened.



Model optimization

To display a 3D-model in a browser, especially on most mobile devices, requires good optimization:

• Apply all modifiers

• Remove unnecessary vertices and polygons that do not make a significant contribution to the visual component

• Reduce the size of textures (for most cases, 1024 by 1024 jpeg images are sufficient, which can be compressed, for example, in 
Photoshop with an optimization value of 60%)

• If there are meshes with the same geometry, then apply linked duplication (Alt-D)

The recommended final size of the uncompressed model is up to 3 MB.



Preparation of additional models

To show different variants of parts of the model (for example, the shape of the roof at the house), it is necessary to prepare 
separate model files.

If you want to replace only geometry, then you need to take into account (in this case, you need to specify the Use only geometry
switch inside the service in the model change settings):

• Only the first mesh in the scene is taken as a replacement geometry

• To reduce the weight of the model, it is better to exclude materials, because only geometry is replaced



Preparing to change textures

For those parts of the model where textures are supposed to be changed, apply low-quality textures inside the model so that it is 
visually possible to form a uv scan, and the weight of the model does not increase significantly, because when loading the model 
in the service, these textures will be replaced with options uploaded in the personal account in good resolution (this applies to 
both conventional textures, and elevation maps).



Preparation for changing parts of the model

If you need to show different versions of parts of the model, 
then you can place meshes of different variants in one place 
of the model.

In the model, they may intersect each other, but in our 
service you can add a visibility switch for each option, 
indicate its initial state and the same group number so that 
your options switch automatically, showing the desired 
option and hiding the rest.

To apply the switch to several bags at the same time, it is 
convenient to include the same parts of the names in the 
names of such meshes. This common part can be specified 
in the properties of the switch.



Uploading a 3D-model to the service 
and configuring the view



Uploading a 3D-model to the service

You can upload either a single file or a zip-archive if the 
model has separate texture files or other data. There 
should be no directories in the archive (only files).

You can also use the catalog of 
ready-made models,
and if you do not find the right 
option, then we can add it for 
free upon request to support.

Step 1

https://configurator.site3d.site/support/en


Errors in loading the 3D-model

If you expected a different result after loading your own 
3D-model (for example, textures shifted or parts of the 
model disappeared), try disabling all items from the model 
loading settings (located above the model loading window) 
and re-loading your 3D model.

Step 1



Uploading versions of the 3D-model for AR

At the first step of the project creation wizard, it is possible 
to download a separate model file in USDZ format to 
demonstrate augmented reality mode for iOS.

This function will be useful if the automatic generation of 
this file does not occur properly.

If you have an implementation of augmented reality 
through other services or a mobile application, then in the 
second step there is an Augmented Reality tab where you 
can insert the URL of a third-party implementation of AR-
mode.

Step 1



Start view

To start working with a 3D-model, we recommend setting 
up the basic parameters of the initial display:

• Position in 3D-space
• Centering the model
• Automatic loading of the model or by click

If required, you can also configure:

• Correction of the centers of the model parts
• Correction by location, size and rotation
• Single rotation of the model around its axis
• Animated icons at startup

Step 2



Scaling and rotation

It is often necessary to adjust the zoom and rotation settings.

Step 2



Animation

Animation tracks only work in GDB format and must be 
embedded in the model itself.

The following features are available:

• Adding labels - text explanations that appear during 
animation playback

• Adding a list of animation options

• Manual control by scrolling with the mouse wheel or 
gesture on the touch screen

Multiple selection of tracks for playback for the model as a 
whole and for variants is supported.

Step 2



Dimensions and floor

You can enable the display of the overall dimensions of the 
model, as well as the display of the floor of the desired 
shape, size, shape and color.

Step 2



Panorama and lighting

The model often looks more impressive together with a 
panorama that fits the meaning. There may be several of 
them, then the user will be able to choose the appropriate 
one when viewing from the list.

Lighting is also of great importance for the visual display of 
the model. You can adjust the color and power of the 
general lighting, as well as the color, power and direction 
for the directional light coming from above and below.

Step 2



Augmented Reality

Here you can:

• Change the title of the AR launch button before loading 
the widget (the button appears if automatic widget 
loading is disabled and models for AR are loaded)

• Specify a link to an external augmented reality launch 
service

• Load markers to launch AR when pointing the 
smartphone camera at a similar product image

Step 2



Graphics and optimization settings

You can configure: 

• Graphics quality
• Volume, reflection, and glow enhancement effects
• Color balance
• Brightness and Contrast settings
• Presence of shadows
• General material
• Facets
• Performance optimization
• Hiding small details
• Auto correction mode

Step 2



Navigation and help window

Next, we configure the navigation buttons and, if 
necessary, the content and the moment when the help 
window appears.

The navigation buttons are divided into the main ones that 
appear in the main menu, and additional ones. The second 
group of buttons is always visible until the main menu is 
open.

Step 2



Design

Here you can customize the appearance of the widget 
interface to match the style of your brand. There is a 
reason for this:

• Design themes

• Additional styling of interface colors and shapes

• Fonts

• The design of the screensaver

• Watermark Overlay

• And much more

Step 2



Creating a 3D-configurator



Selecting a part of the model 
and quickly applying images

At the third step of creating a project, you can click on the 
desired part of the model and select the desired setting.

To quickly overlay your image on the desired part of the 
model, just select the image on your device in the dialog 
box that appears.

Any setting has a field for the name of a part of the model, 
where you can specify only part of the name so that the 
setting applies to several elements of the model that have 
this part of the name.

Step 3



Color settings

You can adjust the color change for any part of the model. 
You can specify a list of your own colors, a palette for 
choosing any color, or both at the same time.

Step 3



Customizing your materials

You can set up simultaneous texture and color changes for any part of the model. To do this, select the material setting. If you
want to use additional texture maps for a more realistic view of the model, you can load them both for all options at once or load 
them separately for each user's choice.

Step 3



General catalog of materials

For each material setting, it is possible to add both your own materials and select the appropriate material from the general
catalog, which is edited on the main page of your personal account. You can also select material from the library of the service.

Step 3



Setting up models

You can set up a change of components for the product. To 
do this, you can specify a list of models for any of its parts 
that will replace this part of the product.

You can also place models from the list on the surface of a 
certain part of the main 3D model (see the example).

Step 3



Setting up visibility switches

You can hide and show parts of the model as separate 
switches, or by combining them into groups. In the second 
case, switching the visibility of one part of the model will 
affect the visibility of others.

Step 3



Size adjustment

Individual parts of the model can be resized along three 
coordinate axes with the following features:

• Size control only on the right axes

• Setting the initial, minimum and maximum values, as 
well as the change step

• Maintaining proportions

• Repetition of the texture pattern depending on the size 
of the part of the model

• Specifying the unit of measurement

Step 3



Tags and links

A block of labels is used for visual text hints of individual 
parts of the model. They can be styled to suit your 
preferences.

When you click on the label, a convenient selection of 
colors and textures is displayed (if there are appropriate 
settings for the same part of the model as the label).

Each element of the model can serve as a link to internal 
sections of the site or external resources.

Step 3



Cost and order form

The cost of the finished product, which can be displayed in 
the widget, may depend on the choice of materials and 
other settings.

You can also enable the ability to apply directly from the 
widget.

Step 3



Embedding the 3D-model on the site



Embedding a 3D-model into any website

There are several ways to embed a project on a website:

• Inserting the 3D-widget code (you need to specify the 
site domain in the list of domains, as well as the product 
code in the first step, if you want to use the container 
type for the widget "With the product code")

• Adding a link to view in a separate browser tab

• Export as a 2D-image

• Creating a video review

The widget can work on any website creation engines, 
including inside website builders.

Step 4

There are two bright buttons for quickly inserting one project 
onto the site: one copies the code, and the other forms a file 
with more detailed instructions for implementing your model.



Embedding a 3D-model to Tilda

To insert a 3D widget into the Tilde website builder:

• Copy the code in the "Code for any site" section on the 
4th step

• Add a Zero-block to the Tilde and paste the copied code 
there

Step 4



Embedding a 3D-model to Wordpress

To easily add your project to a website created on the 
Wordpress platform, you need to:

• Install our plugin

• Copy the shortcode at step 4 of the project creation 
wizard and paste it into the right place on your site

Step 4

https://wordpress.org/plugins/site3d-configurator


Embedding a 3D-model to the Creatium

To export a project to Creatium website builder, you need to:

• Download the plugin number on the page
• Import the plugin by number into an empty block of your site on Creatium
• Copy the project ID at step 4 of editing the 3D widget in our service and paste it into the corresponding field of the component

in Creatium

Step 4

https://creatium.io/library/configurator-site3d?promo=3d-configurator


Creating instructions for implementing 3D-models
for your employees and dealers

On the main page of your personal account:

• The button for generating a letter to the dealer in order 
to tell about the possibility of using 3D models of the 
manufacturer.

• The button for generating instructions for implementing 
the created projects into your Internet resources.



Additional tools



Smart AR

On the main page of your personal account or on the 
fourth step of any of the projects, you can get a code to 
insert a smart AR mode button on the website.



Statistics

For analytics, at the fourth step, the number of rotations of 
the 3D-model is available in the block of additional tools, so 
that you can assess the level of involvement of the site 
visitor in your product.



Working with a large number of 3D-models



Massive loading of models

To download multiple models at the same time (create a 
large number of projects), there is a button "Edit projects" 
on the main page of your personal account.

Before that, you need to create a zip archive with the 
models (they can be nested in folders). In this case, the 
names of the model files will be used as the title and 
product code.

This code can be used for more convenient integration into 
the site, when instead of the project ID, you can use a 
combination of the user ID and the product code (for more 
information, see the export section).

If the product code matches, the previously created project 
will be updated.



Applying scene parameters to other projects

In the second step of creating a 3D-widget, there is a 
button so that you can apply the scene parameters to 
other projects.

You can select the project categories to which you want to 
apply the scene parameters of the current project, as well 
as which parameters will be applied.



Examples of using the service



3D-configurator with a change of the main model

• In the first step, you load a primitive geometry model 
(for example, a cube) with the same dimensions as the 
real product

• Click on the model, select "Add models" and upload the 
necessary model files in GLB format in the list of 
options.

• If desired, you can add other settings, such as changing 
the material. In this case, models of different product 
variants must have model elements with the same name 
(or with a common part of the name). All these common 
parts will have different materials.



Configuring modular products

Consider a 3D configurator for a modular sofa.

First, we will prepare a 3D model in Blender. To do this, we 
will create a replaceable module that we will turn into the 
necessary options.

Next, we will add the necessary combinations of modules. 
At the same time, it is advantageous to clone identical 
elements using the link (Alt + D) for faster loading.

We place all combinations in the center of the coordinates 
and name their component elements with a common part. 
In our example, these are "var_1", "var_2" and "var_3".

We assign our own material to the upholstery and pillows. 
We assign the part of the name "pillow" to the pillows.

Exporting the finished model to GLB.

(preparation of the 3D-model)



Configuring modular products

We are creating a new project in our service. Uploading the 
prepared 3D-model.

In the "Settings" block, on step 3, click on the plus icon and 
select "Add models". In the name of the part of the model, 
select "base". Next, we create a list of module options and 
enter "var_1", "var_2" and "var_3" as the name of the model 
part.

We add a change of materials for upholstery and pillows.

Adding a visibility switch for the pillows. In the "Related 
settings" block, specify the pillow material setting. When 
hiding the pillows, this setting will not be active.

The modular sofa configurator is ready. In step 4, you can 
get the code to insert it on the site.

(creating a project in the service)



Constructor with user textures

Let's consider a 3D configurator of a fire extinguisher with 
a custom image (print) applied to it.

First, we will prepare a 3D model in Blender. To do this, we 
will create a separate transparent surface "image", which 
will repeat the contours of the main part of the fire 
extinguisher, where the user's image will be placed.

Next, we apply the initial image and adjust the UV scan 
accordingly so that the texture lies flat on our surface.

Exporting the finished model to GLB.

(preparation of the 3D-model)



Constructor with user textures

We are creating a new project in our service. Uploading the 
prepared 3D model.

We add the material with the "Load your texture" mode 
enabled at the part of the model where the custom image 
should appear. In our case, this is the "image" surface.

Adding an empty version of the material. We can also add 
other prepared versions of the images on the fire 
extinguisher.

We can also add a color setting for the same part of the 
model, since the user can upload images on a transparent 
background.

(creating a project in the service)



3D-configurator with nested categories

For each category and subcategory (model settings), which 
should only show the next choice to the user, rather than 
replacing one part of the model with another, load a 
primitive geometry model (for example, a cube), preferably 
with the same dimensions as the largest version of the 
product.

Next, assign the options for these settings in the "Related 
settings" block the settings that should be activated when 
the user selects these options.

Write to our support team and we will send you an 
example of this project so that you can follow the analogy 
to create your own 3D configurator.

https://configurator.site3d.site/support


Configurator with moving models

• Upload your 3D-model of the floor of a room or the 
ground of a street space or choose the appropriate 
option from our catalog (we recommend models with an 
area of 1 sq. m). For example, by the "Landscape" tag.

• Add, if necessary, settings for sizing and changing 
materials for the uploaded model.

• You add settings for model variants that can be placed 
on the surface of the loaded floor or ground model, with 
the movement mode enabled.



Creating mockups

• Upload your 3D-model or one from our catalog (we 
recommend models with the "Mockups" tag)

• Upload materials (our models have already prepared 
places to insert your design)

• Export the mockup in a convenient form for you



3D-tour based on 3D-models

With the help of our service, you can create 3D-tours of any space. To do this, you need to download a model of this territory and 
place labels between which you can move.

The labels should be linked to individual parts of our model, and also have the movement mode enabled, where you can 
customize the overview, opening a window with a description and other useful functions.



More on the website
configurator.site3d.site

Embed 3D-models on the website
and boost sales

info@site3d.site

@site3d_support

https://configurator.site3d.site/
mailto:info@site3d.site
https://t.me/site3d_support

	Слайд 1
	Слайд 2
	Слайд 3
	Слайд 4
	Слайд 5
	Слайд 6
	Слайд 7
	Слайд 8
	Слайд 9
	Слайд 10
	Слайд 11
	Слайд 12
	Слайд 13
	Слайд 14
	Слайд 15
	Слайд 16
	Слайд 17
	Слайд 18
	Слайд 19
	Слайд 20
	Слайд 21
	Слайд 22
	Слайд 23
	Слайд 24
	Слайд 25
	Слайд 26
	Слайд 27
	Слайд 28
	Слайд 29
	Слайд 30
	Слайд 31
	Слайд 32
	Слайд 33
	Слайд 34
	Слайд 35
	Слайд 36
	Слайд 37
	Слайд 38
	Слайд 39
	Слайд 40
	Слайд 41
	Слайд 42
	Слайд 43
	Слайд 44
	Слайд 45
	Слайд 46
	Слайд 47
	Слайд 48
	Слайд 49
	Слайд 50
	Слайд 51
	Слайд 52
	Слайд 53
	Слайд 54
	Слайд 55
	Слайд 56
	Слайд 57
	Слайд 58
	Слайд 59
	Слайд 60
	Слайд 61
	Слайд 62
	Слайд 63
	Слайд 64
	Слайд 65
	Слайд 66

